Markowitz Module
The objective of this module is to calculate efficient portfolio compositions under various
conditions (short sales allowed or not, riskless lending or borrowing or not) and under
simplifying assumptions (full Markowitz variance model, single index model, constant
correlation model, multiple index model).
See Elton and Gruber: Modern Portfolio Theory and Investment Analysis, 5th ed., Chapters 4,
5, 6, 7, 8, and 9 for the theory behind, and description of, the models used in this section of
the program.
The Overview section presents an overall description of the module and suggestions on how to
use it.
Help is provided on the following topics.
File
Edit
Asset
Group
Optimizer
Options
Overview
The Markowitz module allows you to calculate efficient portfolio compositions under various
conditions (short sales allowed or not, riskless lending or borrowing or not) and under
simplifying assumptions (full Markowitz variance model, single index model, constant
correlation model, multiple index model).
All analyses are performed on a group of securities. A group is usually defined by selecting a
list of securities from an existing asset data base (Definitions of the various data bases and
tables are provided under the Data Types heading.) To create a group, you must first load an
asset/time series data base using the File/Open or File/Import menu items. (A shortcut
File/Open button is also available on the button bar, located immediately under the menu bar.)
The default extension for an asset data base file is .ats, and default data bases named
"stock97.ats", "funds97.ats" and "index97.ats" are provided with the software.
Once the asset data base is loaded and displayed in a data grid, a group/time series can be
created using the Asset/Create Group menu item and saved using File/Save. A default
group/time series named "sample.gts" is provided with the software.
From a group/time series table, the Group menu items can be used to calculate and display
various measures of the expected returns, volatility, and cross-correlation of the stocks
comprising the group. Depending on the assumptions made, the results are displayed as a
group/correlation table, group/single index table, group/constant correlation table, or
group/multiple index table. Any group type can be saved using Group/Save table as and
retrieved using File/Open.
You can then use the Optimizer to calculate the efficient frontier under various conditions
(short sales allowed or not, riskless lending or borrowing or not), and display it graphically and
numerically.
See Elton and Gruber: Modern Portfolio Theory and Investment Analysis, 5th ed., Chapters 4,
5, 6, 7, 8, and 9 for the theory behind, and description of, the models used in this section of
the program.
Data Types

The following types of data bases and tables are used in the software. See Elton and Gruber:
Modern Portfolio Theory and Investment Analysis, 5th ed., Chapters 4, 5, 6, 7, 8, and 9 for the
theory behind, and description of, the models used in this section of the program.
asset/time series - default extension .ats
Time series of return on investment for a number of stocks, mutual funds or indices.
Example: stock97.gts
group/time series - default extension .gts
Time series of return on investment for a group of assets. A group time/series is usually a
subset of an asset/time series.
Examples:sample.gts, index97.gts
group/correlation table - default extension .gct
Table of expected returns, standard deviation and correlation coefficients corresponding to a
group/time series.
Example :sample97.gct
group/single index table - default extension .gsi
Table of expected return, standard deviation and Beta coefficients corresponding to a
group/time series. The Beta coefficient
calculations are based on an index selected from a group/time series (e.g., the default file
"index97.gts").
Example:sample97.gsi
group/constant correlation table - default extension .gcc
Table of expected return, standard deviation and user-defined constant correlation coefficient
corresponding to a group/time series.
Example: sample97.gcc
group/multiple index table - default extension .gmi
Table of expected return, standard deviation and regression coefficients corresponding to a
group/time series. The regression
coefficients are based on up to five indices selected from a group/time series (e.g.,
"index97.gts").
Example:sample97.gmi
Related topics:

Group
Data File Descriptions

Data File Descriptions
The Investment Portfolio software includes 11 data files. These data files are intended to be
used with the software for pedagogical purposes only. Although every attempt has been made
to ensure data accuracy, the authors, publisher, software developers, and
data sources disclaim all responsibility for any inaccuracies.
"stock97.ats" contains monthly historical returns from January 1987 through December 1996
(10 years) on the following 24 stocks:
American Brands, Inc.
American Express Co.
Anheuser Busch
Chase Manhattan Bank
Owens Corning

AMBRND
AMEXP
ANBUSCH
CHASE
CORNING

Exxon Corp.
Georgia Pacific Corp.
General Electric Co.
General Motors Corp.
Goodyear Tire & Rubber Co.
Huffy
International Business Machines
Eastman Kodak Co.
Kroger Company
Eli Lilly & Co.
Merck & Co., Inc.
Merrill Lynch
Mobil Corp.
NYNEX
Olin Corp.
Pepsico, Inc.
Sears Roebuck & Co.
Waste Management, Inc.
Xerox, Inc.

EXXON
GAPAC
GE
GM
GYEAR
HUFFY
IBM
KODAK
KROGER
LILLY
MERCK
MERRILL
MOBIL
NYNEX
OLIN
PEPSI
SEARS
WASTE
XEROX

"index97.ats" contains monthly historical returns from January 1987 through December 1996
(10 years) on the following fourteen indices:
CRSP SBBI S&P 500 Stock Index
CRSP Value-Weighted NYSE Stock Index
CRSP Equal-Weighted NYSE Stock Index
Russell 2000 Stock Index
CRSP SBBI 30-Day T-Bill
Corporate Bond Index
Government Bond Index
Mortgage Bond Index
High Yield Bond Index
Fama/French Market Index
Fama/French Size Index
Fama/French Book-To-Market Index
FFSMB Plus TBILL
FFHML Plus TBILL

S&P500
(with reinvested dividends)
CRSP VW
CRSP EW
R 2000
TBILL
CORP BD
GOVT BD
MTG BD
HIYLD BD
FFMKT (not in excess-return form)
FFSMB
FFHML
FFSMB1
FFHML1

"fund97.ats" contains monthly historical returns from January 1987 through December 1996
(10 years) on 45 mutual funds. Each mutual fund is given a six-letter name. The first three
letters in the fund name indicate the fund's investment objective as follows:
BCP = corporate bond fund
BGV = government bond fund
BHY = high yield bond fund
BIN = international bond fund
BMG = government mortgage bond fund
BMM = government money market fund
MBL = balanced mixed fund
MTR = total return mixed fund
SAG = aggressive growth stock fund
SEI = equity income stock fund
SGR = growth stock fund
SIN = international stock fund
SMK = stock market index fund
SSS = small-cap stock fund
The following mutual funds are included:

Acorn Inv: Acorn Fund
AIM Balanced/A
AIM Equity: Constellation
AIM: High Yield/A
Alliance Balanced Shs/A
American Balanced
American National Income
Babson Bond Trust: Port L
Calvert Soc Inv: Mgd Grth
Colonial High Yield Sec/A
Composite Bond & Stock/A
Delaware Ltd Term Govt/A
DFA: US 9-10 Small Company
Dodge & Cox Balanced
Federated Govt 2-5 Yrs
INVESCO Adv: Income/C
Lexington GNMA Income
Lexington Wldwd Emerg Mkt
Matterhorn Growth Fund
MFS World Governments/A
Oppenheimer Equity Income/A
Phoenix Srs: Convertible
Phoenix Srs: Growth
Pilgrim Amer Magnacap/A
Pilgrim Govt Sec Inc Grth/A
Putnam Convert Inc Grth/A
Putnam Voyager/A
Rea-Graham: Balanced
Safeco Income
Scudder International
Seligman Growth/A
Sequoia Fund
Stratton Monthly Dividend
T Rowe Price Intl Stock
T Rowe Price New Horizons
Templeton Funds: Foreign
Twentieth Century: Ultra
United Income
United International Grth
Value Line Special Situations
Value Line US Govt Sec
Vanguard Explorer
Vanguard Index: 500 Port
Vanguard MM Rsv: Federal
Vanguard World: US Growth

SSSACN
MBLAIM
SAGAIM
BHYAIM
MBLALL
MBLAMB
SEIAMN
BCPBAB
MTRCAL
BHYCOL
MBLCOM
BGVDEL
SMKDFA
MBLD&C
BGVFED
BGVINV
BMGLEX
SINLEX
SGRMAT
BINMFS
SEIOPP
MTRPHC
SGRPHX
MTRPIL
BGVPIL
MTRPUT
SAGPUT
MBLREA
SEISCO
SINSCD
SGRSEL
SGRSEQ
SEISTN
SINTRP
SSSTRP
SINTMP
SSS20C
SEIUNI
SINUNI
SAGVAL
BGVVAL
SSSVAN
SMKVAN
BMMVAN
SGRVAN

"valuea97.val" and "valueb97.val" contain stock valuation data for the 24 stocks contained in
"stock97.ats".
"valuea97.val" has valuation date as of January 2, 1996.
"valueb97.val" has valuation date as of January 2, 1997.
"option97.opt" contains option valuation data for 7 of the stocks contained in "stock97.ats".
"future97.fut" contains futures valuation data for the following financial futures:
S&P 500 Stock Index
91-Day T-Bills
Japanese Yen

STK1
TBL1
CUR1

British Pound
Canadian Dollar
German Mark

CUR2
CUR3
CUR4

"bonda97.bdc" and "bondc97.bdc" contain bond valuation data for Treasury coupon bonds.
"bondb97.bdz" and "bondd97.bdz" contain bond valuation data for Treasury zero-coupon
bonds.
"bonda97.bdc" and "bondb97.bdz" have valuation dates as of February 15, 1996.
"bondc97.bdc" and "bondd97.bdz" have valuation dates as of August 15, 1996.
Related Topics:

Data Types

Data Grid
Numerical data bases are presented in spreadsheet-like tables identified as data grids.
A row of buttons at the top of the grid and a column of buttons on the left of the grid contain
column headings and row headings, respectively. These headings are often abbreviated.
Selecting a heading button (by clicking it with the mouse) and pressing the <F1> key pops up
a message box containing the full description.
The content of a cell in a data grid can be edited by double-clicking on it, or by single-clicking
on it and pressing the <Enter> key. Grid elements not available for editing are grayed out.
The structure of the table (number and headings of rows and columns) can be modified using
the Edit menu item or the equivalent button bar elements.
File menu
The File menu allows you to retrieve data from or store data to the disk, and to send data to
the printer.
Related Topics
New
Open
Save
Save as
Import
Print
Printer setup
Exit
New
Use New to create a new data base.
You will be prompted for the type of data base you want to create (asset/time series,
group/time series, group/correlation; table, group/single index table,
group/constant
correlation table, group/multiple index table).
An empty data grid will be displayed, ready for editing.
Open
Use the Open command to load an existing data base. The default extensions for data bases
are:

.ats for asset/time series
.gts for group/time series
.gct for group/correlation table
.gsi for group/single index table
.gcc for group/constant correlation table
.gmi for group/multiple index table
The data will be displayed in a data grid.
Save/Save as
Use Save to save the current data base under its current name.
Use Save as to save the current data base under a new name.
Import
Use this command to import a data base. Whenever you are importing your own data set, this
is the command you must use. The file format that must be used to import a data set is
compatible with the output generated by most commercial spreadsheet packages (Tab
delimited file). In Excel, for instance, proceed as follows. First click on File. Then click on
Save as. When the screen appears, choose “Text (Tab Delimited) (*.TXT)” in the box titled
Save as Type. This will automatically save the file in a format that can be read into the
investment portfolio software.
The data for an asset data base file must follow the format of the sample file "stock97.txt"
provided with the software. This file can be loaded in your favorite spreadsheet program and
be used as a template.
The first line defines the table structure, and must contain the asset names (one column per
asset).
The following lines define the monthly total returns (in %). The first column in each line is the
date in YYMM format.
Print/Printer setup
Use Print to print the current data grid.
Use Printer setup to specify the printer to be used, the paper orientation (portrait or
landscape), etc.
Exit
Use this command to exit from the software and return control to Windows.
You will be warned if the current data base has been edited since last saved, and you will have
the opportunity to save it before exiting.
Edit
From the Edit menu:
Use Copy graph to copy a currently active graph on the clipboard.
Use Change asset to modify the row structure of an asset data grid.
Use Change period to modify the column structure of an asset or group data grid.

Use Change group to modify the row structure of a group data grid.
Asset
Use the Create Group menu item to define a group/time series from the currently- loaded
asset/time series data base.
Group
Use the Group menu items to prepare group data for running the optimizer.
(Note: Most of these items are also available as labeled "tabs" on top of the data grid. Clicking
a tab has the same effect as selecting the corresponding menu item.)
When a group/time series (tab label: "TS Table") is loaded and displayed in the data grid, the
Time series graph item allows you to plot the time series on a graph.
The Covariance table (tab label: "Cov Table") and Correlation table (tab label: "Cor Table")
items calculate the expected return, standard deviation and, respectively, the covariance or
correlation coefficients for all stocks in the group.
The Single index (tab label: "SI Table") item calculates the expected return, standard deviation
and Beta for all stocks in the group.
You will be prompted to select a group time series in which to select the market index needed
to calculate the Beta coefficient. Once a group/single index table is displayed, you can use
Beta Graph to plot the stocks in the Beta-expected return space.
The Constant correlation (tab label: "CC Table") item calculates the expected return and
standard deviation for all stocks in the group. You will be prompted to enter the constant
correlation coefficient.
The Multiple index (tab label: "MI Table") item calculates the expected return, standard
deviation and regression coefficients for all stocks in the group. You will be prompted to select
a group time series in which to select the market indices needed to calculate the regression
coefficients.
Save table as allows you to save a correlation, covariance, constant correlation, or single or
multiple index table to a file.
Related topic: Data Types
Optimizer
When a group table is displayed in the data grid, the Run Optimizer item under the Optimizer
menu (and the corresponding element in the button bar) is active.
When you run the optimizer, you are prompted for calculation options:
short sales allowed/with riskless lending and borrowing
short sales allowed/no riskless lending and borrowing
short sales not allowed/with riskless lending and borrowing
short sales not allowed/no riskless lending and borrowing
Lintner short sales allowed/with riskless lending and borrowing
If an option with riskless lending and borrowing is included, you are prompted to supply values
for the lending and borrowing rates.
See Elton and Gruber: Modern Portfolio Theory and Investment Analysis, 5th ed., Chapters 4,
5, 6, 7, 8, and 9 for the theory behind, and description of, the models used in this section of
the program.

The optimizer will then compute and display the efficient frontier on a plot.
The Zoom graph and Unzoom graph can be used to magnify or reduce the graph.
You can drag the cursor (white diamond) on the graph, using the mouse, to explore numerical
values of the expected return and standard deviation on the efficient frontier. Press the Tab
key or the arrow keys to snap the cursor to the tangent portfolio (in the cases where riskless
lending and borrowing is allowed) or to the corner portfolios (short sales allowed/no riskless
lending and borrowing). Use Show Portfolio to display the composition of the portfolio at the
current cursor location.
Use the Graph Securities item to plot individual securities on the efficient frontier diagram.
Clicking on the dot representing an individual security displays its name, expected return, and
standard deviation in the lower right corner of the graph window.
The Edit Custom Portfolios item allows you to define up to three portfolios containing securities
selected from the current group. You have the option to plot these custom portfolios on the
efficient frontier diagram. Clicking on the dot representing a portfolio displays its name,
expected return, and standard deviation in the lower right corner of the graph window. The
Save Custom Portfolio and Load Custom Portfolio allow you to save the current set of custom
portfolios or load previously saved ones.
If short sales are not allowed, the "corner portfolios" (points on the efficient frontier where
stocks enter or leave the portfolio) are marked on the plot. Use the <Tab> key or the arrow
keys to locate the cursor exactly at the corner portfolios.
Use the Run editor menu item to return to the data grid, and run the optimizer with new
options.
Options
Use the Return menu item to enter data in a time series data base in the form of monthly total
return (in percent).
Use the Price and Dividend menu item to enter data in a time series data base in the form of
current stock price and annual dividend.
Check the Hide cursor item if you do not wish to display the cursor (white diamond) and cross
hairs on the efficient frontier graphs.
Equilibrium Module
The objective of this module is to present the Capital Asset Pricing Model (CAPM) and illustrate
buy/sell decisions based on the position of individual securities relative to the security market
line in Beta-Return space. See Elton and Gruber: Modern Portfolio Theory and Investment
Analysis, 5th ed., Chapter 13 for the theory behind, and description of, the models used in this
section of the program.
The Overview section presents an overall description of the module and suggestions on how to
use it.
Help is provided on the following topics.
File
Print
Printer setup
Exit

Edit
Copy graph
CAPM
Graph CAPM
Graph securities
Clear securities
Overview
The Equilibrium module allows you to compare the risk(Beta)/return relationship of individual
securities to the equilibrium risk/return relationship calculated under the CAPM model.
The first step is to select a security market line in Beta-Return space using the CAPM/Graph
CAPM menu item. (A shortcut is available via a button on the button bar, which is located
immediately under the menu bar).
Once the security market line is displayed, specific company stocks can be analyzed using the
CAPM/Graph securities menu item or the corresponding button.
Graph CAPM
Use this menu item to plot a security market line in Beta-Return space.
The software will prompt you for the origin of data (data base or manual input).
If you choose to use data from the data base, the software will first prompt you to select a
group/time series index file (e.g., "index97.gts"). It will then prompt you to select a riskless
security index and an index representative of the market as a whole.
If you choose to input data manually, you will be prompted to enter the return of the riskless
security (Rf) and of the market (Rm) in a dialog box.
The software then displays a plot of the security market line, defined by the points [0,Rf] and
[1,Rm], in Beta-Return space.
Multiple security market lines, corresponding to different (Rf, Rm) sets, can be plotted
simultaneously if the "clear graph" check box (in the "origin of data" dialog box) is left
unchecked.
Data Types
The following types of data bases and tables are used in the Equilibrium module.
group/time series - default extension .gts
Time series of return on investment for a group of assets. A group time/series is usually a
subset of an asset/time series.
Examples: index97.gts
group/single index table - default extension .gsi
Table of expected return, standard deviation and Beta coefficients corresponding to a
group/time series. The Beta coefficient calculations are based on an index selected from a
group/time series (e.g., the default file "index97.gts").
Example: sample97.gsi

Related topics:

Data File Descriptions

Data File Descriptions
The Investment Portfolio software includes 11 data files. These data files are intended to be
used with the software for pedagogical purposes only. Although every attempt has been made
to ensure data accuracy, the authors, publisher, software developers, and data sources
disclaim all responsibility for any inaccuracies.
"stock97.ats" contains monthly historical returns from January 1987 through December 1996
(10 years) on the following 24 stocks:
American Brands, Inc.
American Express Co.
Anheuser Busch
Chase Manhattan Bank
Owens Corning
Exxon Corp.
Georgia Pacific Corp.
General Electric Co.
General Motors Corp.
Goodyear Tire & Rubber Co.
Huffy
International Business Machines
Eastman Kodak Co.
Kroger Company
Eli Lilly & Co.
Merck & Co., Inc.
Merrill Lynch
Mobil Corp.
NYNEX
Olin Corp.
Pepsico, Inc.
Sears Roebuck & Co.
Waste Management, Inc.
Xerox, Inc.

AMBRND
AMEXP
ANBUSCH
CHASE
CORNING
EXXON
GAPAC
GE
GM
GYEAR
HUFFY
IBM
KODAK
KROGER
LILLY
MERCK
MERRILL
MOBIL
NYNEX
OLIN
PEPSI
SEARS
WASTE
XEROX

"index97.ats" contains monthly historical returns from January 1987 through December 1996
(10 years) on the following fourteen indices:
CRSP SBBI S&P 500 Stock Index
CRSP Value-Weighted NYSE Stock Index
CRSP Equal-Weighted NYSE Stock Index
Russell 2000 Stock Index
CRSP SBBI 30-Day T-Bill
Corporate Bond Index
Government Bond Index
Mortgage Bond Index
High Yield Bond Index
Fama/French Market Index
Fama/French Size Index
Fama/French Book-To-Market Index
FFSMB Plus TBILL
FFHML Plus TBILL

S&P500 (with reinvested dividends)
CRSP VW
CRSP EW
R 2000
TBILL
CORP BD
GOVT BD
MTG BD
HIYLD BD
FFMKT (not in excess-return form)
FFSMB
FFHML
FFSMB1
FFHML1

"fund97.ats" contains monthly historical returns from January 1987 through December 1996
(10 years) on 45 mutual funds. Each mutual fund is given a six-letter name. The first three
letters in the fund name indicate the fund's investment objective as follows:

BCP = corporate bond fund
BGV = government bond fund
BHY = high yield bond fund
BIN = international bond fund
BMG = government mortgage bond fund
BMM = government money market fund
MBL = balanced mixed fund
MTR = total return mixed fund
SAG = aggressive growth stock fund
SEI = equity income stock fund
SGR = growth stock fund
SIN = international stock fund
SMK = stock market index fund
SSS = small-cap stock fund
The following mutual funds are included:
Acorn Inv: Acorn Fund
AIM Balanced/A
AIM Equity: Constellation
AIM: High Yield/A
Alliance Balanced Shs/A
American Balanced
American National Income
Babson Bond Trust: Port L
Calvert Soc Inv: Mgd Grth
Colonial High Yield Sec/A
Composite Bond & Stock/A
Delaware Ltd Term Govt/A
DFA: US 9-10 Small Company
Dodge & Cox Balanced
Federated Govt 2-5 Yrs
INVESCO Adv: Income/C
Lexington GNMA Income
Lexington Wldwd Emerg Mkt
Matterhorn Growth Fund
MFS World Governments/A
Oppenheimer Equity Income/A
Phoenix Srs: Convertible
Phoenix Srs: Growth
Pilgrim Amer Magnacap/A
Pilgrim Govt Sec Inc Grth/A
Putnam Convert Inc Grth/A
Putnam Voyager/A
Rea-Graham: Balanced
Safeco Income
Scudder International
Seligman Growth/A
Sequoia Fund
Stratton Monthly Dividend
T Rowe Price Intl Stock
T Rowe Price New Horizons
Templeton Funds: Foreign
Twentieth Century: Ultra
United Income
United International Grth
Value Line Special Situations
Value Line US Govt Sec
Vanguard Explorer

SSSACN
MBLAIM
SAGAIM
BHYAIM
MBLALL
MBLAMB
SEIAMN
BCPBAB
MTRCAL
BHYCOL
MBLCOM
BGVDEL
SMKDFA
MBLD&C
BGVFED
BGVINV
BMGLEX
SINLEX
SGRMAT
BINMFS
SEIOPP
MTRPHC
SGRPHX
MTRPIL
BGVPIL
MTRPUT
SAGPUT
MBLREA
SEISCO
SINSCD
SGRSEL
SGRSEQ
SEISTN
SINTRP
SSSTRP
SINTMP
SSS20C
SEIUNI
SINUNI
SAGVAL
BGVVAL
SSSVAN

Vanguard Index: 500 Port
Vanguard MM Rsv: Federal
Vanguard World: US Growth

SMKVAN
BMMVAN
SGRVAN

"valuea97.val" and "valueb97.val" contain stock valuation data for the 24 stocks contained in
"stock97.ats".
"valuea97.val" has valuation date as of January 2, 1996.
"valueb97.val" has valuation date as of January 2, 1997.
"option97.opt" contains option valuation data for 7 of the stocks contained in "stock97.ats".
"future97.fut" contains futures valuation data for the following financial futures:
S&P 500 Stock Index
91-Day T-Bills
Japanese Yen
British Pound
Canadian Dollar
German Mark

STK1
TBL1
CUR1
CUR2
CUR3
CUR4

"bonda97.bdc" and "bondc97.bdc" contain bond valuation data for Treasury coupon bonds.
"bondb97.bdz" and "bondd97.bdz" contain bond valuation data for Treasury
zero-coupon bonds.
"bonda97.bdc" and "bondb97.bdz" have valuation dates as of February 15, 1996.
"bondc97.bdc" and "bondd97.bdz" have valuation dates as of August 15, 1996.
Related Topics:

Data Types

Button bar
The button bar, located immediately below the menu bar at the top of the main window, offers
shortcut access to the most commonly-used menu items.
Active buttons are identified by color icons. Inactive buttons are grayed out to indicate that the
corresponding function is not accessible from the current state of the program.
When the mouse pointer rests on top of any button bar element, a yellow help balloon pops up
to identify the button functionality.
Graph securities
Use this menu item to plot selected securities on the same graph as the security market line.
The software will prompt you to select a group/single index file.
securities contained in this file on the Return-Beta plot.

It will then display the

You can identify the securities corresponding to each point on the plot, and read their Beta and
Return values, using the left/right arrow keys or the <Tab> key.
File menu
The File menu allows you to send data to the printer.
Use Print to print the current data grid.
Use Printer setup to specify the printer to be used, the paper orientation (portrait or
landscape), etc.

Use Exit to exit from the software and return control to Windows.
Edit
From the Edit menu, use the Copy Graph command to copy a currently-active graph to the
clipboard.
CAPM
Use the CAPM menu to plot security market lines in Beta-Return space, according to the
Capital Asset Pricing Model, and to plot individual securities on the same graph to help make
buy/sell decisions.
Related Topics:
Graph CAPM
Graph securities
Clear securities
Graph CAPM
Use this menu item to plot a security market line in Beta-Return space.
The software will prompt you for the origin of data (data base or manual input).
If you choose to use data from the data base, the software will first prompt you to select a
group/time series index file (e.g., "index97.gts"). It will then prompt you to select a riskless
security index and an index representative of the market as a whole.
If you choose to input data manually, you will be prompted to enter the return of the riskless
security (Rf) and of the market (Rm) in a dialog box.
The software then displays a plot of the security market line, defined by the points [0,Rf] and
[1,Rm], in Beta-Return space.
Multiple security market lines, corresponding to different (Rf, Rm) sets, can be plotted
simultaneously if the "clear graph" check box (in the "origin of data" dialog box) is left
unchecked.
Graph securities
Use this menu item to plot selected securities on the same graph as the security market line.
The software will prompt you to select a group/single index file.
securities contained in this file on the Return-Beta plot.

It will then display the

You can identify the securities corresponding to each point on the plot, and read their Beta and
Return values, using the left/right arrow keys or the <Tab> key.
Clear securities
Use this menu item to clear the security data points from the security market line plot.

